
WIRE TUTORIAL

June 2017



WIRE TUTORIAL

June 2017
© 2017 CNC Software, Inc. – All rights reserved.
Software: Mastercam 2018

Terms of Use
Use of this document is subject to the Mastercam End User License Agreement. The
Mastercam End User License Agreement can be found at:

http://www.mastercam.com/companyinfo/legal/LicenseAgreement.aspx

Be sure you have the latest information!
Informationmight have changed or been added since this document was published.
The latest version of the document is installed with Mastercam or can be obtained
from your local Reseller. A ReadMe file (ReadMe.PDF) – installed with each release –
includes the latest information about Mastercam features and enhancements.

ii

http://www.mastercam.com/companyinfo/legal/LicenseAgreement.aspx


Table of Contents

Introduction 5

1 Single Contour Toolpaths 7

Exercise 1: Getting Started with Toolpath Creation 8

Exercise 2: Setting Up Single Contour Stock 12

Exercise 3: Selecting Single Contour Geometry 14

Exercise 4: EnteringWirepath Parameters 17

Exercise 5: Backplotting the Single Contour Toolpath 20

Exercise 6: Changing Toolpath Parameters 21

Exercise 7: Backplotting the Updated Toolpath 25

Exercise 8: Posting the Toolpath 26

2 Multiple Contour Wirepaths 29

Exercise 1: Preparing the Multiple Contour Part 30

Exercise 2: Selecting Multiple Contour Geometry 32

Exercise 3: EnteringMultiple Contour Toolpath Parameters 33

Exercise 4: Adjusting the Chains 35

Exercise 5: Verifying the Toolpath 38

3 No Core Toolpaths 41

Exercise 1: Preparing the No Core Part 42

Exercise 2: Setting Up No Core Stock 44

iii



Exercise 3: Selecting No Core Geometry 45

Exercise 4: Entering No Core Toolpath Parameters 47

Exercise 5: Backplotting the No Core Toolpath 48

4 4-axis Toolpaths 51

Exercise 1: Importing the 4-axis Machine 52

Exercise 2: Preparing the 4-axis Part 53

Exercise 3: Setting Up 4-axis Stock 55

Exercise 4: Selecting 4-axis Geometry 57

Exercise 5: Entering 4-axis Toolpath Parameters 59

Exercise 6: Backplotting the 4-axis Toolpath 62

Conclusion 65

Mastercam Resources 65

Contact Us 66

iv



5

Introduction

MastercamWire delivers comprehensive wire EDM software with powerful toolpaths
and techniques. This tutorial provides an introduction to MastercamWire workflow
and best practices.

Tutorial Goals
l Practice creating and selecting part geometry for your toolpaths.

l Enter appropriate toolpath parameters for different toolpath types.

l Make changes to your toolpath and update the tool motion.

l Verify your toolpathmotion using several different tools. 
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Single Contour Toolpaths

A wire contour toolpathmachines parts that have the same shape at the top
and bottom. This lesson focuses on the basic workflow used to create a wire
contour toolpath.

Lesson Goals
l Open a part file and assigning a machine definition.

l Create a contour toolpath with a single contour.

l Backplot to check the toolpath.

l Post the toolpath.
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Exercise 1: Getting Started with Toolpath Creation
In this exercise, you open a part and select a machine definition that simulates a wire
EDM machine.

1. Start Mastercam using your preferredmethod:

a. Double-click Mastercam's desktop icon.

OR

b. LaunchMastercam from the Windows Start menu.

2. Select the default metric configuration file:

a. Click the File tab.

b. Choose Configuration fromMastercam's Backstage View to open the
System Configuration dialog box.

c. Choose ...\mcamxm.config <Metric> from the Current drop-
down list.

Wire Tutorial—1: Single Contour Toolpaths
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d. ClickOK.

3. Choose File, Open and select the part file, single_contour.mcam
provided with the tutorial.

The gear shape is the single contour for this toolpath. MastercamWire also
needs a thread point for the toolpath, which is the point where the machine
threads the wire, often a pre-drilled hole in the material. By creating a thread
point in Mastercam and selecting it as part of the toolpath, it becomes asso-
ciative, whichmeans the toolpath updates if the point moves.

4. On theWireframe tab, choose Point Position.

5. In the Point Position function panel, choose Thread Point.

Wire Tutorial—1: Single Contour Toolpaths



The thread point symbol may be hard to see depending on your background
color. Before you begin to identify the thread point, zoom into the area if you
need to see it more clearly.

6. Drag and drop the graphics window prompt and press [Spacebar] to access
FastPoint mode and type in the point coordinates.

Because the prompt window hides anything under it, youmay not want to
move it over information displayed in Toolpaths Manager, or any used sidebar
areas.

7. Type X-40, Y0.2, Z0 and press [Enter]. A point with the thread symbol displays
to the left of the part.

8. ClickOK in the Point Position function panel to complete the function.

You now have the geometry you need for a basic contour toolpath.

Wire Tutorial—1: Single Contour Toolpaths
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9. On the Machine tab, chooseWire, Default to select the default wire machine
definition.

Themachine definition is a model of your machine tool's capabilities and fea-
tures. It provides a template for setting upmachining jobs.

Choosing the machine definition adds a machine group and a toolpath group to
the Toolpaths Manager. Toolpaths you create are placed at the red arrow in
this list.

10. Choose File, Save As and save the part under a different file name. This pro-
tects the original tutorial file from being overwritten.

Wire Tutorial—1: Single Contour Toolpaths



Exercise 2: Setting Up Single Contour Stock
Defining a stockmodel helps you visualize your toolpaths more realistically. You can
see your stock boundaries with the part geometry when you backplot or verify
toolpath operations.

1. In the Toolpaths Manager, expand the Properties under the Machine Group,
and click Stock setup.

2. Enter the following values to set the stock boundaries:

l Enter Y75, X75, and Z10 for the stock dimensions.

l Enter a Z value of 10 for the stock origin.

Wire Tutorial—1: Single Contour Toolpaths
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3. Select Display and Fit screen to show the stock boundaries and include the
boundaries when you use the Fit to Screen function.

4. ClickOK to complete the stock setup.

5. Right-click in the graphics window and choose Isometric (WCS) to get a
clearer view of the stock boundaries.

Wire Tutorial—1: Single Contour Toolpaths



Exercise 3: Selecting Single Contour Geometry
Selecting geometry for toolpaths in MastercamWire is called chaining. Chaining is
the process of selecting and linking pieces of geometry to form the foundation of a
toolpath, surface, or solid. When you chain geometry, you select one or more sets of
curves (lines, arcs, and splines) that have adjoining endpoints. You can also chain
points, which is important for setting thread and cut positions in your toolpath.

In MastercamWire, you can chain either wireframe or solid geometry for your
toolpaths. This example involves chaining wireframe geometry.

Wire Tutorial—1: Single Contour Toolpaths
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1. On the Wirepaths tab, choose Contour.

2. To associate the point with the toolpath, select the thread point you created as
the first chain.

Note: When the stock size is close to the part size, the thread point is often out-
side the stock.

3. Select the gear shape as the second chain. Click on the area closest to the
thread point. The green arrow showing chain direction should go in a coun-
terclockwise direction.

Wire Tutorial—1: Single Contour Toolpaths



4. ClickOptions on the Chaining dialog box to access additional chaining para-
meters.

5. Select Break closest entity to thread point.

This option breaks the entity closest to the thread point into two pieces so you
begin the toolpath with a perpendicular move. This creates the shortest motion
possible between the thread point and the chained geometry.

6. ClickOK on the Chaining Options dialog box.

Wire Tutorial—1: Single Contour Toolpaths
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7. ClickOK on the Chaining dialog box to continue to set the wirepath parameters
in the Wirepath - Contour dialog box.

Exercise 4: Entering Wirepath Parameters
The next step is to set the values for each aspect of the toolpath. The Wirepath - Con-
tour dialog box includes the options you need to program your part.

1. ChooseWire/Power from the Tree View pane on the left side of the dialog box.

A power library contains wire EDM machine-specific settings for the material
you are cutting.

A power library can contain up to 24 passes. A pass is a single pathmade by
the wire around a contour. Each pass includes unique power settings needed
to cut a certain material type on a certain wire EDM machine. For example,
Pass 1 in the library may correspond to a rough cut, Pass 2 a tab cut, and
Passes 3 - 5 finish cuts (also known as skim cuts).

Wire Tutorial—1: Single Contour Toolpaths



2. Enter 0.2 for the wire diameter.

This toolpath will only have one pass, so you do not need to make other
changes.

3. Choose Compensation from the Tree View pane.

4. Set the compensation type to Computer.

This option computes the compensated wirepath and does not output control
codes for compensation. This allows you to see a more accurate rep-
resentation of the toolpathmotion.

5. Choose Taper from the Tree View pane.

This page sets various toolpath heights, including the UV and XY heights that
indicate the top and bottom of the stock.

Wire Tutorial—1: Single Contour Toolpaths

18



19

6. Set the Rapid height, UV trim plane, andUV height to 15.0. The rapid
height is the Z height of the upper wire guide for rapid moves. The UV trim
plane sets the position of the upper wire guide.

7. ClickOK to complete the toolpath.

8. ClickOK to close the Chain Manager.

The Chain Manager displays for access to the Change at point or sorting
options. These options are discussed in Lesson 2.

The following picture shows the completed toolpath.

9. Choose File, Save from the menu to save your progress.
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Exercise 5: Backplotting the Single Contour Toolpath
Mastercam’s Backplot shows the path the wire takes to cut your part. This display lets
you spot errors in the program before youmachine the part.

1. Click Backplot selected operations at the top of the Toolpaths Manager.

2. ClickDisplay tool andDisplay holder on the Backplot dialog box to show the
wire and guides during backplot.

3. Click Play on the Backplot VCR bar above the graphics window to run the back-
plot.

The wire moves around the part for a single rough pass.

Wire Tutorial—1: Single Contour Toolpaths
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4. ClickOK on the Backplot dialog box to exit the function.

Exercise 6: Changing Toolpath Parameters
Although the simple contour toolpath you just created will machine the part, additional
options in MastercamWire canmake your machiningmore effective. Change para-
meters and update the operation to include these new settings.

1. Click the Parameters icon in the Toolpaths Manager for the Wire Contour oper-
ation.
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2. ChooseWire/Power from the Tree View pane.

3. For Pass 1, enter 0.035 for theWire Overburn.

4. Click the up arrow next to Pass 1 to enter values for Pass 2.

5. Enter the following values for Passes 2, 3, and 4:

l Pass 2: Wire Diameter 0.2, Wire Overburn 0.02

l Pass 3: Wire Diameter 0.2, Wire Overburn 0.01

l Pass 4: Wire Diameter 0.2, Wire Overburn 0

Note: As the passes get closer to the final part shape, the wire cuts less mater-
ial and the overburn decreases.

6. Choose Cut Parameters from the Tree View pane.

Wire Tutorial—1: Single Contour Toolpaths
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7. Set the following parameters on this page (see following graphic of new Cut
Parameters values):

l Enter 3 for Additional skim cuts (before tab). These additional passes
create a better finish on the part.

l Select Tab and enter 1.0 for the Tab Width. Creating a tab on the part
keeps it attached to the stock.

l Set the cuttingmethod to Reverse. Instead of cutting in one direction and
re-threading the wire, this optionmakes the wire go in the opposite dir-
ection at the end of each pass.

Note: Notice the change in the cut list. The toolpathmotion now includes four
passes around the chain and a short move to cut the tab.

8. Choose Stops from the Tree View pane.

Because you added a tab cut with a stop on the Cut Parameters page by select-
ing the Tab option and setting the Tab Width, some of the options on the
Stops page are already selected.

9. Select As glue stop for the output stop code.

Wire Tutorial—1: Single Contour Toolpaths



A glue stop is an optional stop (using anM01 code) that pauses the machine
before the tab cut, and allows the operator to secure the part to prevent drop-
out after the tab cut.

10. Choose Leads from the Tree View pane.

11. Select Line and arc for the lead in and Arc and line for the lead out.

Starting and ending the toolpath away from the part reduces the possibility of
leaving a burr on the part.

Wire Tutorial—1: Single Contour Toolpaths
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12. Enter 0.125 for the arc radius and 60 for the arc sweep on the entry and exit
moves.

13. SelectMax lead out and set the distance to 0.3.

This option shortens the lead out move, instead of forcing the wire to travel
from the end of the contour to the cut point.

14. ClickOK to complete the parameter changes.

15. Click Regenerate all selected operations in the Toolpaths Manager to
update the contour toolpath with your changes.

16. Choose File, Save to save your part.

Exercise 7: Backplotting the Updated Toolpath
Use Backplot to verify the changes youmade to the contour toolpath.

1. Click Backplot selected operations.

2. Click Play to run the backplot.

The wire moves to the end of the contour, leaves a tab, travels back and forth
around the part during the skim cuts, then cuts the tab.
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3. ClickOK to complete the backplot.

Exercise 8: Posting the Toolpath
Post processing, or posting, refers to the process by which the toolpaths in your
Mastercam part files are converted to a format that can be understood by your
machine tool’s control (for example, G-codes). A special program called a post pro-
cessor, or post, reads your Mastercam file and writes the appropriate NC code. Gen-
erally, every machine tool or control will require its own post processor, customized to
produce code formatted to meet its exact requirements.

1. Click Post selected operations at the top of the Toolpaths Manager.

Wire Tutorial—1: Single Contour Toolpaths
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2. Set the post processing parameters as shown. These settings will ask if you
want to save the NC file and will display the resulting file in your default text
editor.

3. ClickOK.

4. Select a location for the NC file and click Save.

Wire Tutorial—1: Single Contour Toolpaths



5. Mastercam Code Expert opens in Editor mode and displays the posted NC
code. Scroll through the code and see if it meets your expectations.

6. Edit the file and save if necessary.

7. Close the Code Expert window.

Congratulations on completing your first Wire toolpath! The next lesson involves mul-
tiple contours.

Wire Tutorial—1: Single Contour Toolpaths
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Multiple Contour Wirepaths

In addition to single contour wirepaths, MastercamWire allows you to cut
multiple contours from a single piece of stock in a single operation. You can
select the parts as a group and then sort the chains to generate the toolpath
motion you want.

Lesson Goals
l Select multiple contours.

l Create multiple tabs and stops.

l Use verification to check the toolpath.
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Exercise 1: Preparing the Multiple Contour Part
1. Choose File, Open and select the part file, multiple_contours.mcam

provided with the tutorial.

This part includes three contours, three thread points, and four mounting
holes. The default Wire machine definition is already selected.

2. In the Toolpaths Manager, expand the Properties under the Machine Group
and click Stock setup.

3. Enter the following values to set the stock boundaries and display them in the
graphics window:

l Click Select corners and select opposite corners of the rectangle sur-
rounding the contours.

l Enter 10 for the Z stock dimension.

Wire Tutorial—2: Multiple Contour Wirepaths
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l Change the Stock Origin Z coordinate to 10.

l Select Display and Fit screen to show the stock boundaries and include
the boundaries when you use the Fit to Screen function.

4. ClickOK to complete the stock setup. If necessary, right-click in the graphics
window and select Isometric (WCS).

Wire Tutorial—2: Multiple Contour Wirepaths



5. Choose File, Save As and save the part under a different file name. This pro-
tects the original tutorial file from being overwritten.

Exercise 2: Selecting Multiple Contour Geometry
Instead of chaining each contour, you can quickly select multiple parts using window
chaining.

1. On the Wirepaths tab, choose Contour.

2. Right-click in the graphics window and choose Top (WCS) to view the part from
above.

3. ClickWindow on the Chaining dialog box.

Wire Tutorial—2: Multiple Contour Wirepaths
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4. Click at the first point and then drag to the second point shown in the following
picture and click again to draw the window around the parts.

5. Click the thread point on the left part as the approximate start point.

6. ClickOK on the Chaining dialog box to continue to the toolpath parameters.

Exercise 3: Entering Multiple Contour Toolpath Parameters
The parameters for this toolpath are similar to the ones you entered in Lesson 1.

1. Select Cut Parameters in the Tree View pane.

2. Set the following parameters on this page:

l Select Tab and enter 2.0 for the tab width. Creating a tab on the part
keeps it from dropping out of the stock.

l SelectMake tab cutoff move with skim cut to make the toolpath
motionmore efficient.

l Select Skim cuts after tab to add a finish pass after cutting the tab.
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l Set the cuttingmethod to Reverse.

The toolpathmotion now involves two cuts for each chain, with the rough
cut including the stop and the tab cut.

3. Choose Compensation from the Tree View pane.

4. Select Computer for the compensation type, and set the compensation dir-
ection to Left.

5. Choose Stops from the Tree View pane.

6. Select For each tab to add a stop code before the tab cut on each chain and
As glue stop to add them as optional stops. 

7. Choose Leads from the Tree View pane.

8. Set the following parameters on this page:

l Select Line and arc for the lead in and Arc and line for the lead out.

l Enter 0.5 for the arc radius and 90 for the arc sweep on the entry and
exit moves.

Wire Tutorial—2: Multiple Contour Wirepaths
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l Enter 0.02 for the overlap.

This option eliminates potential burrs by overlapping the start and end of
the contour by the entered amount.

9. Choose Taper from the Tree View pane and set the Rapid height, UV trim
plane, andUV height to 20.0.

10. ClickOK to finish entering the parameters. The Chain Manager opens.

Exercise 4: Adjusting the Chains
Because you selected the contours with window chaining, the chain order may not be
what you would prefer for the toolpath. The Chain Manager displays after you enter
the toolpath parameters so you can adjust the chains and get the toolpathmotion you
want.

Wire Tutorial—2: Multiple Contour Wirepaths



1. Click each Chain Point and Chain in the Chain Manager to see howMaster-
cam chained the contours by default.

2. Right-click in the Chain Manager and choose Sort options. The Sorting dialog
box displays.

Wire Tutorial—2: Multiple Contour Wirepaths

36



37

3. Select the Y+ X- option in the third row.

The red point indicates the start point and the arrow shows the sorting dir-
ection.

4. ClickOK to close the Sorting dialog box.

5. Click through the points and chains again to see the new chaining order from
right to left.

6. ClickOK to close the Chain Manager and the toolpath displays on the three con-
tours.

Wire Tutorial—2: Multiple Contour Wirepaths



7. Save your part file.

Exercise 5: Verifying the Toolpath
Verification is different from backplot because it simulates material removal in addi-
tion to tool motion. The verification displays in a separate window called Mastercam
Simulator.

1. Click Verify selected operations at the top of the Toolpaths Manager.

The stock, wire, and guides display in the Mastercam Simulator window.

2. Right-click in the Simulator window and choose Isometric, then Fit to get a bet-
ter view of the toolpath and wire.

3. Click Play at the bottom of the Simulator window to move through the veri-
fication.

Wire Tutorial—2: Multiple Contour Wirepaths
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4. After the verification is complete, right-click and choose Zoom Window. Draw
a window around the center part to look at the results more closely.

5. Click Remove Chips on the Verify tab and then click on the middle part to see
the slug drop out of the stock.

Wire Tutorial—2: Multiple Contour Wirepaths



You can click on the other slugs as well to see the final tool motion results.

6. Close the Simulator window to return to Mastercam.

Now that you have worked with single contours andmultiple contours, the next lesson
focuses on No Core toolpaths.

Wire Tutorial—2: Multiple Contour Wirepaths
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No Core Toolpaths

No Core toolpaths in MastercamWire remove all material within a boundary
without producing slivers or slugs. The wirepath typically starts at a pre-
drilled hole in the material, and zigzags or spirals outward until all material
within the chained geometry is removed.

Lesson Goals
l Use AutoCursor to select points.

l Create rough and finish passes.

l Use backplot to check the toolpath results.
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Exercise 1: Preparing the No Core Part
1. Choose File, Open and select the part file, no_core.mcam, provided with

the tutorial.

This part is a solid model with a hole in the center. The No Core toolpath will
machine the four additional slots. The default wire machine definition is
already selected, but you need to define a thread point for each slot.

2. Press [Alt+S] to turn off shading, and view the wireframe geometry.

3. Right-click in the graphics window, and choose Top (WCS) to rotate the view.

4. On theWireframe tab, choose Point Position.

5. In the Point Position function panel, choose Thread Point.

Wire Tutorial—3: No Core Toolpaths
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6. Move your cursor to the end of a slot and notice the cursor change to indicate
that you are selecting the center of an arc.

Note: This is Mastercam’s AutoCursor, which detects and snaps to points as
youmove the cursor over geometry. AutoCursor activates whenever Master-
cam prompts you to select a position on the screen.

Wire Tutorial—3: No Core Toolpaths



7. Select the four points shown in the following picture as thread points.

Note: Placing the points close together reduces travel time between the slots.

8. ClickOK in the Point Position function panel to complete the function.

9. Choose File, Save As and save the part under a different file name.

Exercise 2: Setting Up No Core Stock
MastercamWire canmodel stock based onmany different shapes, including solid
models, castings, and cylinders.

1. In the Toolpaths Manager, expand the Properties under the Machine Group
and click Stock setup.

2. Select Cylindrical in the Shape section and select Z as the cylinder axis.

3. Enter 30 for the cylinder height and 40 for the diameter.

Wire Tutorial—3: No Core Toolpaths
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4. ClickOK to complete the stock setup.

Exercise 3: Selecting No Core Geometry
All chains (except thread points) must be a closed shape for No Core toolpaths.

Wire Tutorial—3: No Core Toolpaths



1. On the Wirepaths tab, choose No Core.

2. Select each thread point and its corresponding slot. Select the chain for each
slot close to its thread point.

Note:

l If you were actually machining the part, each thread point would be the
center of a pre-drilled hole for the wire.

l In the Chaining Options dialog box, make sure that Break closest entity
to thread point is unchecked.

3. ClickOK on the Chaining dialog box to complete chaining.

Wire Tutorial—3: No Core Toolpaths
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Exercise 4: Entering No Core Toolpath Parameters
No Core toolpaths can include a rough pass and finish passes. The rough pass typ-
ically removes almost all of the material. The finish passes smooth out rough edges
and can also take off additional material.

1. SelectNo Core in the Tree View pane.

2. Set the Rapid height, UV trim plane, andUV height to 40.0.

3. Select Rough in the Tree View pane.

Mastercam No Core wirepath offers six cuttingmethods for cleaning out the
material. The best practice is to select a cuttingmethod that follows the shape
of your part. For this part, the default Parallel Spiral option works well.

4. Select Finish in the Tree View pane.

5. Select Enable Finish to activate the default finish pass parameters.

6. Set the Compensation type to computer for the finish pass.

7. Select Start pass at closest entity.
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When checked, begins the finish pass starting with the closest endpoint of the
closest entity at the end of the roughing wirepath. When cleared, the finish
pass begins with the first entity in the chain as it was originally selected.

This optionmakes your toolpathmotionmore efficient.

8. ClickOK to generate the toolpath.

9. Save your part file.

Exercise 5: Backplotting the No Core Toolpath
Backplot includes several tools for showing your wire motion.

Wire Tutorial—3: No Core Toolpaths
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1. Click Backplot selected operations at the top of the Toolpaths Manager.

2. SelectQuick verify from the Backplot dialog box.

This option displays a shaded path the width of the wire as the backplot pro-
gresses and gives you a quick way to check if all the material is removed from
the slots.
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3. Click Play to run the backplot. The wire cuts each slot from the inside out. The
shaded area under the tool motion confirms that all the slots are machined
completely.

4. ClickOK to exit backplot.

The last lesson in this tutorial focuses on 4-axis toolpaths, which work well for parts
with different contours in the top and bottom planes.

Wire Tutorial—3: No Core Toolpaths
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4-axis Toolpaths

Use 4-axis toolpaths for parts that require the wire to be in a non-vertical ori-
entation. These parts typically have different geometry in the XY and UV
planes, or the same geometry in a different orientation, such as the gear
used in this lesson.

Lesson Goals
l Select a different machine definition.

l Learn about synchronizationmethods.

l Use TECH libraries.

4



Exercise 1: Importing the 4-axis Machine
Before creating the 4-axis toolpath, youmust import the 4-axis machine included with
this tutorial.

1. Open the 4-axis Machine folder included with this tutorial.

2. Copy the following files:

l GENERIC MAKINO 4X WIRE (TECH).MCAM-CONTROL

l GENERIC MAKINO 4X WIRE MM (TECH).MCAM-WMD

3. To the following folder:

l C:\Users\Public\Documents\shared Mcam2018\CNC_
MACHINES

4. Copy the following Post file:

l Generic Makino 4X Wire (TECH).pst

5. To the following folder:

l C:\Users\Public\Documents\shared
Mcam2018\wire\Posts

The importedmachine is now ready to be used for toolpath creation.

Wire Tutorial—4: 4-axis Toolpaths
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Exercise 2: Preparing the 4-axis Part
1. Choose File, Open and select the part file, 4_axis.mcam, provided with the

tutorial. If the part is not shaded, press [Alt +S] to turn on shading.

This part is a solid model with the thread point and chaining start points
already defined.

Wire Tutorial—4: 4-axis Toolpaths



2. On the Machine tab, chooseWire, Manage List to select a wire machine defin-
ition.

This option lets you select a different machine definition than the default Wire
machine.

3. Select GENERIC MAKINO 4X WIRE MM (Tech).MCAM-WMD from the
machine definition list, and click Add.

This Makino machine uses a .TECH library for the wire power settings, which
you will work with in Exercise 4.

4. ClickOK to close the dialog box.

5. ChooseWire and select the machine you just added to the list.

Wire Tutorial—4: 4-axis Toolpaths
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The Makino machine definition is added to the Toolpaths Manager.

6. Choose File, Save As and save the part under a different file name.

Exercise 3: Setting Up 4-axis Stock
Similar to Lesson 3, a simple cylinder is the best stockmodel for this part.

1. In the Toolpaths Manager, expand the Properties under the Makino Machine
Group and click Stock setup.

2. Enter the following values in the dialog box:

l Select Cylindrical in the Shape section, and select Z as the cylinder axis.

l Enter 40 for the cylinder height and 70 for the diameter.

Wire Tutorial—4: 4-axis Toolpaths



l Select Display and Fit screen to show the stock boundaries.

3. ClickOK to complete the stock setup.

Wire Tutorial—4: 4-axis Toolpaths
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Exercise 4: Selecting 4-axis Geometry
For a 4-axis toolpath, you chain geometry in two planes: the XY plane (lower contour),
and UV plane (upper contour). MastercamWire uses synchronization to determine the
wire motion between the two chains. The sync mode is typically determined by the
part geometry, but MastercamWire offers several options:

l By entity: Matches the endpoint of
each entity. Requires both chains to
have the same number of entities.

l By branch: Matches the contours
by branch points. Requires 3D geo-
metry connecting the upper and
lower contours.

l By point: Matches previously cre-
ated point entities on each chain.

l Manual: Matches the chains of
user-defined areas.

l By node: Matches two or more
parametric splines by their node
points. Requires each spline to have
the same number of node points.

l Manual/density: Matches the
chains and assigns a density for
each chain. If an area has small
radii, use a higher density for a bet-
ter finish.

Note: A branch point is a position where the endpoints of three or more entities
meet and where the chain direction can change.

1. In the Wirepaths tab, choose 4 Axis.

2. Press [Alt+S] to turn off shading andmake it easier to chain the part.

3. Select the thread point to the left of the part as the first toolpath chain.
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4. Select the lower purple contour to the right of the green point. The chain start
arrow should be at the point.

This is the XY plane for the toolpath.

Note: Press [F1] and draw a zoomwindow to focus on a certain area of the
part.

5. Chain the upper contour starting at the green point. Both chains must go in the
same direction and should be clockwise around the part.

Note: Click Reverse on the Chaining dialog box to switch the chain direction.

6. ClickOptions on the Chaining dialog box to access the synchronizationmeth-
ods.
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7. Select by Entity from the Sync mode drop-down list.

This sync mode works for this part because the top and bottom contours have
the same number of entities.

8. ClickOK to close the Chaining Options dialog box.

9. ClickOK again to close the Chaining dialog box and to open the Wirepath - 4
Axis dialog box.

Exercise 5: Entering 4-axis Toolpath Parameters
The machine definition you selected is connected to a .TECH library that contains all
the power information for the wire passes, including register settings, offsets, and
feeds. These settings are designed for this wire machine and control.
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1. ChooseWire/Power from the Tree View pane.

2. Click the Tech button to change the power settings for this toolpath.

The Technology Database dialog box displays.

3. Select Rough & 2 skim(s) from the Sequence drop-down list at the bottom of
the dialog box. This matches the number of passes you will program for this
part.

4. ClickOK to return to the toolpath parameters.

5. Choose Cut Parameters from the Tree View pane.
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6. In the Tabs section, select Equal to make the UV and XY tabs the same size
and enter 1.5 for the XY Tab Width.

7. Choose Compensation from the Tree View pane.

8. Set the compensation type to Computer and set the compensation direction to
Left.

9. Choose Stops from the Tree View pane.

10. Select For each tab to add a stop code before the first tab cut on each chain
and As glue stop to add them as optional stops.

11. Choose Leads from the Tree View pane.

12. Select Line and arc for the lead in and Arc and line for the lead out.

13. ClickOK to generate the toolpath.

14. Press [Alt+S] to view the shaded part with the toolpath.
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15. Save your part file.

Exercise 6: Backplotting the 4-axis Toolpath
Besides the backplot tools you’ve already used, you can backplot your tool motion in
the same Mastercam Simulator window as verification.

1. Click Verify selected operations at the top of the Toolpaths Manager.

2. On the Home tab, checkWorkpiece to shade the solid.
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3. Click Backplot to change to Backplot mode in Mastercam Simulator.

4. The stock no longer displays in the window and the Backplot tab displays at the
top of the screen.

5. Click the Backplot tab and select Enable Vectors to view the 4-axis wire pos-
itions as it moves around the part.

6. Click Play at the bottom of the Simulator window to run the backplot. The wire
moves around the part three times for the one rough and two skim passes.

7. Click the Home tab, and selectWorkpiece to see the final part shape so you
can compare it to the tool motion. TheWorkpiece checkbox toggles to view the
part in different shades of translucency.
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8. Close the Simulator window to return to Mastercam.

9. Save your part.
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Conclusion

Congratulations! You have completed the Wire Tutorial tutorial! Now that you have
mastered the skills in this tutorial, explore Mastercam's other features and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being
constantly developed, and we will addmore as we complete them. Visit our website,
or selectHelp, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful doc-
uments for your version of software in the Documentation folder of your
Mastercam 2018 installation.

l Mastercam Help—Access Mastercam Help by selectingHelp, Contents from
Mastercam's File tab or by pressing [Alt+H] on your keyboard.

l Mastercam Reseller—Your local Mastercam Reseller can help withmost ques-
tions about Mastercam.

l Technical Support—Our Technical Support department (860-875-5006 or
support@mastercam.com) is openMonday through Friday from 8:00 a.m. to
5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users
become familiar with basic Mastercam features and functions. Visit our web-
site, or selectHelp, Tutorials fromMastercam's File tab to see the latest pub-
lications.

l Mastercam University—Mastercam University, an affordable online learning
platform, gives you 24/7 access to Mastercam trainingmaterials. Take advant-
age of more than 180 videos to master skills at your own pace and help
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prepare for Mastercam Certification. For more information onMastercam
University, please contact your AuthorizedMastercam Reseller, visit
www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find a wealth of information at www.-
mastercam.com. For tech tips and the latest Mastercam news, follow us on
Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam).
Visit our YouTube channel to see Mastercam in action
(www.youtube.com/user/MastercamCadCam)! Registered users can search for
information or ask questions on the MastercamWeb forum,
forum.mastercam.com, or use the knowledgebase at kb.mastercam.com.

Contact Us
For questions about this or other Mastercam documentation, contact the Technical
Documentation department by email at techdocs@mastercam.com.
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ATTENTION! UPDATES MAY BE AVAILABLE.
PLEASE REFER TO MASTERCAM.COM/SUPPORT

FOR THE LATEST DOWNLOADS.
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